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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by you 
or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of 
third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  No 
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of 
Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  
Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, 
modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”.  The 
recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.   
“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 

equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-

crime systems; and safety equipment etc. 
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property 
damages (nuclear reactor control systems, military equipment etc.).  You must check the quality grade of each Renesas 
Electronics product before using it in a particular application.  You may not use any Renesas Electronics product for any 
application for which it is not intended.  Renesas Electronics shall not be in any way liable for any damages or losses incurred 
by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas 
Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics.  Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions.  Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas 
Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and 
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because the evaluation 
of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by 
you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility 
of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable laws and 
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.  
Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws 
and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations.  You should not use 
Renesas Electronics products or technology described in this document for any purpose relating to military applications or use 
by the military, including but not limited to the development of weapons of mass destruction.  When exporting the Renesas 
Electronics products or technology described in this document, you should comply with the applicable export control laws and 
regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise 
places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this 
document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of 
unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document 
or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 

(2012.4) 



 

How to Use This Manual 

 

Readers This manual is intended for user engineers who want to understand the features of the 

RL78/I1A in order to design and develop its application systems and programs. 

 

Purpose This manual is intended to give users an understanding how to use Applilet EZ for HCD 

Controller and of the features described in the Organization below. 

 

Organization This manual is broadly divided into the following parts. 

 Overview 

 Installation 

 Starting and Ending 

 Applilet EZ for HCD Controller operation 

 Windows reference 

 

How to Use This Manual It is assumed that the readers of this manual have general knowledge of electrical 

engineering, logic circuits, and microcontrollers. 

 

To understand the overall features of Applilet EZ for HCD Controller 

→Read this manual in the order of the CONTENTS. The mark "<R>" shows 

major revised points. The revised points can be easily searched by copying an 

"<R>" in the PDF file and specifying it in the "Find what:" field. 

 

To learn the details of the hardware features of the RL78/I1A 

→Refer to RL78/I1A User’s Manual (R01UH0169E). 

 

Conventions Data significance:  Higher digits on the left and lower digits on the right 

 Active low representation: xxx (overscore over pin or signal name) 

 Note:  Footnote for item marked with Note in the text 

 Caution:  Information requiring particular attention 

 Remark:  Supplementary information 

 Numerical representation:  Binary ... xxxx or xxxxB 

   Decimal ... xxxx 

   Hexadecimal ... xxxxH 

 



 

Related Documents 

 

The related documents indicated in this publication may include preliminary versions. However, preliminary 

versions are not marked as such. 

 

Documents Related to Devices 

Document Name Document No. 

Japanese English 

RL78/I1A User’s Manual; Hardware R01UH0169J R01UH0169E 

 

Documents Related to Development Hardware Tools 

Document Name Document No. 

Japanese English 

RL78/I1A DC/DC LED Control Evaluation Board User’s Manual R01UH0363J R01UH0363E 

 

Documents Related to Development Software Tools 

Document Name Document No. 

Japanese English 

CubeSuite+ V.2.02.00 User’s Manual Start R20UT2865J  R20UT2865E 

Analysis R20UT2868J  R20UT2868E 

Message R20UT2871J  R20UT2871E 

RL78 Design R20UT2684J  R20UT2684E 

RL78, 78K0R Coding R20UT2774J  R20UT2774E 

RL78, 78K0R Build R20UT2623J  R20UT2623E 

RL78 Debug R20UT2867J  R20UT2867E 

 

Caution The related documents listed above are subject to change without notice. Be sure to use the latest version 

of each document for designing. 
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CHAPTER 1 OVERVIEW 

1. 1 Overview 

 

Applilet EZ for HCD Controller is a tool used to automatically generate software for microcontrollers for LED lamps 

and illumination and to write programs. 

By specifying dimming and the communication mode on the GUI, Applilet EZ for HCD Controller can be used to 

easily generate the programs that control the software for microcontrollers that control LEDs at a constant current. It 

can also be used to automatically write the generated software to the flash memory in microcontrollers via a USB 

cable and to check operation by using an evaluation board. 

By using Applilet EZ for HCD Controller, the labor hours for controlling LEDs, developing communication software, 

and checking operation can be significantly reduced. In addition, application systems for LED lamps and illumination 

that use microcontrollers can be evaluated without microcontroller expertise. 

 

 

 

Caution  For DALI communication, it's possible to output source files at the time of IEC62386-102 ed1.0 standard 

selection. 

 The hex files are output at the time of IEC62386-102+207 ed1.0 and the IEC62386-102 ed2.0 standard 

selection. 

 For IEC62386-102+ 207 ed1.0 and IEC62386-102 ed2.0, a library is prepared separately. 

 For details, contact your local Renesas Electronics sales. 

PC (GUI) 

Evaluation board 

(RL78/I1A AC/DC Full digital 3ch LED control unit, etc.) 

USB cable 

<Configuration example> 

<R> 
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1. 2 Host Machine, Software, and Hardware Configurations 

 

The host machine, software, and hardware configurations for using Applilet EZ for HCD Controller are shown below. 

 

(1) Host machine 

 OS: Windows 7 (32-/64-bit mode) 

 CPU, Memory:   Must satisfy the recommended requirements for each OS 

 USB: USB 1.1 interface or later 

(2) Software 

 Applilet EZ for HCD Controller (this software) 

 Software that can edit CSV files, such as Microsoft Excel® 

 Assembler/compiler/integrated development environment/device fileNote 1 

<Renesas ElectronicsNote 2> 

Integrated Development Environment: CubeSuite+  CA78K0R 

<IAR Systems> 

Integrated development environment: IAR Embedded Workbench 

CompilerNote 4:   IAR C/C++ Compiler for Renesas RL78 

AssemblerNote 4:   IAR Assembler for Renesas RL78 

Device fileNote 4:   DF-RL78I1A-EE_xxxxxNote3 

<KPIT (GCC)> 

Tool package:   GNURL78Note5 

 Renesas Flash Programmer 

 ············· Software for flash memory programming 

 Board driver  

              ············· Driver used to make the host PC recognize the evaluation board  

                      (RL78/I1A AC/DC Full digital 3ch LED control unit, etc.) 

(3) Hardware 

 Evaluation board 

RL78/I1A DCDC LED Control Evaluation Board 

 ·································· This is an evaluation board for LEDs that uses the RL78/I1A.  

Red, green, and blue LEDs are mounted on the board. The LEDs can be 

controlled by using the internal features of the L78/I1A and an FET without the 

constant-current driver IC. 

RL78/I1A AC/DC Full digital 3ch LED control unit 

 ·································· This is an evaluation unit for the LED power source with the RL78/I1A 

implemented manufactured by Tessera Technology Inc. It can control the power 

factor correction circuit (PFC) and up to three channels of LED. Writing to the 

microcomputer and debugging are handled by using the on-board USB interface 

or E1. 

RL78/I1A AC/DC 1 converter LED evaluation unit 

 ·································· This is an evaluation board for LED control by non-isolated 1 converter system 

that uses the RL78/I1A. Writing to the microcomputer and debugging are 

handled by using the on-board USB interface or E1. 

RL78/I1A AC/DC 2 converter LED evaluation unit 

＜R> 
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 ·································· This is an evaluation board for LED control by non-isolated 2 converter system 

that uses the RL78/I1A. Writing to the microcomputer and debugging are 

handled by using the on-board USB interface or E1. 

RL78/I1A Lighting Communication Master Evaluation Board 

 ·································· It is possible to use as a communication master board for controlling various 

lighting evaluation board. Each interface of DALI protocol communication, 

DMX512 protocol communication and infrared remote control are supported. In 

addition, the communication only by the switch operation on the master board is 

also possible. 

 

 

Notes1. The supported development environment differs depending on the OS used. 

2. When using a software tool manufactured by Renesas Electronics, software can be automatically 

generated using Applilet EZ for HCD Controller without installing a device file. 

3. "xxxx" indicates the version. 

4. Applilet EZ for HCD may not operate depending on the versions of the complier, assembler, and device 

file. 

5. Use e2studio manufactured by Renesas as the integrated development environment for GNURL78. 

 

Cautions1. It is recommended that the latest service pack be installed for any OS. 

2. Applilet EZ for HCD Controller requires the compiler, assembler, or integrated development 

environment and device file of an Renesas Electronics or IAR Systems product. 

Remarks1. For details about how to obtain compilers, assemblers, integrated development environments, 

and device files, contact your local Renesas Electronics sales representative. 

2. For details of the evaluation boards, refer to each user’s manual. 
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CHAPTER 2 INSTALLATION 

2. 1 Installing Application 

 

The following applications must be installed to use Applilet EZ for HCD Controller. 

 Microsoft .NET Framework 4.5 or later 

 Microsoft Visual Studio 2013 Visual C++ Redistributable Package 

 Applilet EZ for HCD Controller 

 Compiler, assembler, or integrated development environment and device fileNote 1 

 

Notes1. Install one of the following as the compiler, assembler, integrated development environment and device 

file. Install the device file according to the chip mounted on the evaluation board. 

<Renesas Electronics> 

Integrated development environment: CubeSuite CA78K0R 

 

<IAR Systems> 

Integrated development environment: IAR Embedded Workbench 

Compiler: IAR C/C++ Compiler for Renesas RL78 

Assembler: IAR Assembler for Renesas RL78 

Device file: DF-RL78I1A-EE_xxxxx 

 

<KPIT (GCC)> 

Tool package: GNURL78 

 

Remark For details about how to obtain compilers, assemblers, integrated development environments, and 

device files, contact your local Renesas Electronics sales representative. 

 

  

<R> 
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2. 1. 1 Installing .NET Framework 

Install .NET Framework 4.5, which is required for using the Applilet EZ for HCD Controller. 

 

(a) Download the required files 

Download following files required for installation from the Microsoft website. 

 

(1) .NET Framework 4.5Web installer 

NDP452-KB2901954-Web.exe: Web installer  

(When a web access is possible, use a Web installer. Using a web installer, Language Pack which 

matches the language of the OS is also installed.) 

 

(2) .NET Framework 4.5 offline installer & Language pack installer 

NDP452-KB2901907-x86-x64-ALLOS-ENU.exe: Offline installer 

(When a web access is not possible, use an offline installer. Using an offline installer, Language 

Pack is not installed. For using in language other than English of Windows, install Language Pack 

after installing.NET Framework 4.5 by an offline installer.) 

 

(b) Install .NET Framework 

This step is described offline installation of .NET Framework 4.5. 

It is necessary to install Language Pack separately from the .NET Framework 4.5 by the offline 

installation. 

 

When "NDP452-KB2901907-x86-x64-ALLOS-ENU.exe" is double-clicked, "User Account Control" dialog 

box is displayed. 

 

 

 

Click [Yes]. 

 
  

<R> 
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"Microsoft .NET Framework 4.5 Setup" dialog box is displayed. 

 

 

 

After confirming the license terms, when agreeing, check "I have read and accept the license terms" and 

click [Install]. 

Proceed with the installation by following the instructions that will be displayed in the wizard window. 

 

(c) Install Language pack 

When using the language other than English of Windows, install the Language Pack. 
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2. 1. 2 Installing Visual C++ Redistributable Package 

Install Visual C++ Redistributable Package, which is required for using the Applilet EZ for HCD Controller. 

 

(a) Download the required files 

Download following files required for installation from the Microsoft website. 

 

(1) Visual Studio 2013 Visual C++ Redistributable Package installer 

Vcredist_x86.exe 

 

(b) Install Visual C++ Redistributable Package 

When "Vcredist_x86.exe" is double-clicked, "Visual C++ redistributable package Setup" dialog box is 

displayed. 

 

 

 

After confirming the license terms, when agreeing, check "I agree to the license terms and conditions" 

and click [Install]. 

Proceed with the installation by following the instructions that will be displayed in the wizard window. 

 

  

<R> 
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2. 1. 3 Installing Applilit EZ for HCD Controller 

Double-click the AppEZHCD_V90J.msi file to start the installation wizard of Applilet EZ for HCD Controller. 

 

 

 

Click the [Next] and proceed with the installation by following the instructions that will be displayed in the wizard 

window. 

 

2. 1. 4 Installing compiler, assembler, or integrated development environment and 

device file 

Install the compiler, assembler, or integrated development environment and device file according to each 

product manual. 

 

Caution After installation, the compiler to be used must be selected. For details, refer to 3.1.1 (a)Setting up at 

the first startup and (B)Compiler setting. 
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2. 1. 5 Windows [start] menu and shortcut icon 

When installing of the application has been completed normally, the following folder will be copied into the 

specified installation folder. 

 

Figure2-1 Windows [start] Menu 

 

 

 

The following shortcut icon is displayed on the Windows desktop. 

 

Figure2-2 Shortcut Icon 

 

 

 

2. 2 Installing USB Driver 

 

USB driver is required when using an evaluation board. The USB driver for evaluation board is stated in the disk 

media provided or in an e-mail message. 

The first time that the host machine is connected to the evaluation board via the bundled USB cable, Windows’ 

[Found New Hardware Wizard] appears, prompting for installation of the USB driver. 

Proceed with the installation by following the windows that will be displayed. 

 

 

2. 3 Uninstall 

 

To uninstall Applilet EZ for HCD Controller, C compiler, and assembler, go to the Windows Control Panel and 

select [Programs and Features] (in Windows 7). 
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CHAPTER 3 STARTING AND ENDING 

3. 1 Starting 

 

To start Applilet EZ for HCD Controller, go to the Windows [start] Menu and select [All Programs] →[Programs] →

[Applilet EZ for HCD Ver9.0] → [Applilet EZ for HCD Ver9.0] (refer to Figure2-2 Windows [start] Menu), or double 

click the shortcut icon on the Windows Desktop (refer to Figure2-3 Shortcut Icon). 

Once Applilet EZ for HCD Controller is started, the following Main window opens. 

 

Figure3-1 Main Window When Starting 

 

 

<R> 
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3. 1. 1 Setting up at the first startup 

 

(a) Setting up at the first startup 

If starting Applilet EZ for HCD Controller for the first time after installation, the following window is displayed. 

Select the compiler to use from the compiler name that is displayed in the "Compiler Selection" window, 

click [OK]. 

 

 

 

 

(b) Compiler setting 

When changing the compiler, perform it as follows. 

On [Setting] menu, select [Select Compiler], and then select the compiler name to be used. 
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(c) Compiler folder setting 

On the [Setting] menu, select [Compiler Folder] to specify the folder in which the compiler to be used is 

installed. Inputting the path is not usually required because the path is automatically retrieved. If the path 

is not automatically entered, enter it manually. 

 

 

 

 

(d) Project folder setting 

Specifying the folder in which to save the generated configuration file (*.hcd) and the project folder to create. 

On the [Setting] menu, select [Project Folder]. The following dialog box will then be displayed. 

 

 

 

Change the location where the *. hcd and the project folder are saved as required. 

 
  

Folder in which to save the generated 

configuration file (*.hcd) . 

Folder in which to save the project folder. 
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(e) Flash programming setting 

The COM Port connected to the flash memory programmer or the board is specified here. 

On the [Setting] menu, select [Flash Program…] .The following dialog box will be displayed. 

 

 

 

Select the connection method from the list box [Tool:]. 

 

 

 

When selecting [E1], the [Power supply:] item is displayed. 

 

 

 

If not supplying power from the E1, sets the [None], and if supplying, set according to the input voltage of 

the board to be used. 
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If selecting [COMx], [COM Port:] item is displayed. 

COM port that is currently connected to the PC is displayed in the [COM Port] list. Select the COM port to 

be used. 

 

If setting ends, click [OK]. 

 

 
3. 2 Ending 
 

To exit from Applilet EZ for HCD Controller, go to the Main window’s [File] menu and select [Exit]. 
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CHAPTER 4 APPLILET EZ FOR HCD CONTROLLER OPERATION 

This chapter describes the operation flow, from automatically generating object codes (*.hex) by using Applilet EZ for 

HCD Controller and writing to the flash memory, up to checking operation by using the evaluation board. 

 

4. 1 Operation Flow 

 

 
  

Start Applilet EZ for HCD Controller 

Setting up the evaluation board 

Menu -> [Project] -> [cpu] 

 

Refer to 4.2 

Setting up at the first startup (refer to 3.1.1) 
-Compiler 
-Setting file folder 
-Project file folder 
-Flash programming 

page)Mode setting (to the next page) 
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Caution  Some modes may be unavailable, 
depending on the board 
specifications. For details, see 
the each board’s manual.  

Save the project 

Generation, writing, and evaluation (refer to 4.4) 

Mode setting 

In this mode, the dimming levels are changed by 
the switch connected to the board. 

Switch mode 

Refer to 4.3.7 

In this mode, the LEDs are dimmed using the 
remote control signal reception function on the 
board. 

 

IR remote control mode 

Refer to 4.3.8 

In this mode, the LEDs are dimmed according to 
the A/D converted values. 

 

Analog Input mode 

Refer to 4.3.3 

In this mode, the LEDs are dimmed by using 
commands depending on the type of 
communication. 
Specify the communication format, communication 
command type, and channels to use for serial 
communication. 

 

Serial Command mode 

Refer to 4.3.4 

In this mode, the LEDs are dimmed according to 
the input fixed values. 

 

Fix mode 

Refer to 4.3.1 

In this mode, the LEDs are dimmed using the DALI 
protocol. 

 
↓ 

 

DALI mode 

Refer to 4.3.6,Chapter 5 

Select 

In this mode, LED dimming can be continuously 
changed. The output pattern can be specified as in 
art software. 

 
 

 

Variable mode 

Select Click the [Edit] button 

Refer to 4.3.2 
 

It is the mode for exclusive use of the lighting 
communication master evaluation board. 
set the transmission command of the DALI / IR to 
nine switch on the evaluation board. 

 

Master Control mode 

Refer to 4.3.9 

In this mode, the LEDs are dimmed using the 
DMX512 protocol. 

 
 

 

DMX512 mode 

Refer to 4.3.5,Chapter 5 

Select 

Click [Setting] 

Setting up the evaluation board (from the previous 
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4. 2 Setting Up the Evaluation Board 

 

In the menu, select [Project] and then [CPU] to set up the evaluation board in the dialog box below. 

Performing this setup updates the specified mode displayed in the main window. 

 

(1) Target: 

Select the evaluation board to use. 

 

(2) Device: 

If an evaluation board is selected, the mounted microcontroller is displayed. (This setting cannot be 

changed.) 

 

(3) Clock Source: 

Select the clock to use. This setting might be fixed depending on the setting of (1). 

 

(4) Frequency (MHz): 

Select the frequency. This setting might be fixed depending on the setting of (1) and (3). 

 

(5) Channel X: 

Specify the channels to enable by selecting their [Enable] checkboxes. 

Specify the color of the lighting of each channel by using the [Color] buttons. 

These settings might not be selectable or changeable depending on the setting of (1). 

Enter the max current level of each channel in [Limit]. 

* This setting may be unavailable, depending on the board. 

 

(6) Enable ‘On Chip Debug’.: 

If this checkbox is selected, a program that enables on-chip debugging is generated. 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 
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(7) All Channel Synchronized.: 

If this checkbox is selected, the brightness of all selected channels will be the same. 

If only one channel is selected, this checkbox is disabled. 

 

(8) Logarithmic dimming control.: 

Select this checkbox to logarithmically change the dimming of the LEDs. 

If this checkbox is not selected, dimming values are handled as direct values. If the checkbox is selected, 

the specified value is converted to logarithmic value. 

 

4. 3 Mode Setting 

 

Select a mode to use from Dimmer Program on the main window and set the details. 

 

4. 3. 1 Fix mode 

In this mode, the LEDs are dimmed according to the input fixed values. 

If multiple channels are set to synchronization mode (refer to 4.2 (7)), dimming values can be specified only 

for channels that have lower numbers. (The dimming value cannot be entered for the other channels, but the 

same dimming value applies.) The corresponding [Chx.] (where x is the channel number) turns black for the 

other channels to synchronize. 

 

 

 

(1)  Select the [Fixed Duty] button in Dimmer Program (This button is selected by default.). 

(2) Enter a value into the [Ch1] to [Ch4] boxesNote or select a color from the [Select Color] drop-down list. 

(3) Click 
 
icon or select Menu → [File] → [Save] to save the project. 

 

Note  The values that can be entered vary depending on the evaluation board. 
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4. 3. 2 Variable mode 

In this mode, LED dimming can be continuously changed. 

The output pattern can be specified as in art software. 

 

 

 

(1) Select the [Variable] button in Dimmer Program. 

(2) Click the [Edit] button to open a separate window, shown below. 

Edit the output pattern in this window. 

 

 

 

 

 

 

 

 

 

(a) Selecting the channel to operate (b) Selecting the operation mode (c) Editing tools 

The cursor 

position and 

specified values 

are displayed. 

Specify the number of data units and speed. Specify repetition. Field for editing and displaying 

the brightness curve 
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(a) Selecting the channel to operate 

Select the channel to edit. Only channels that can be edited can be selected. 

Select all channels or individual channels. 

The brightness curve of a selected channel is displayed as a bold line. 

 

(b) Selecting the operation mode 

 

 

Range selection 

mode 

A range can be selected by left-clicking and then dragging the mouse in the brightness 

curve editing field. Editing tools are used for the selected range. 

 

Freehand line 

mode 

A freehand line can be drawn by left-clicking and then dragging the mouse in the 

brightness curve editing field. This mode is enabled only if one operation channel is 

selected. 

 
Clear mode 

All data of the selected channel is cleared. 

 

CSV editing 

mode 

The brightness values are output to a CSV file and an editing application (the 

application associated with the extension .csv) starts. Control does not return to 

Applilet EZ for HCD Controller until the application is closed. 

 

(c) Editing tools 

 

 
Straight line 

Turns changes in the values of a selected channel or selected range into a straight 

line. 

The straight line connects the values of the start and end positions in the selected 

range. 

 
Maximization 

Sets the values in the selected range to their maximum specifiable values. 

 
Minimization 

Sets the values in the selected range to their minimum value (0). 

 

Color 

specification 

Specifies the color of a value in the selected range from the color specification 

window. This tool is enabled only if all operation channels (All) and a range are 

selected. 

 

Shifting 

Shifts the values in the selected range to the left, right, up, or down by one point. If 

these buttons are clicked while holding down the [Ctrl] key, the values shift in 10- 

point units. 

 

Cutting 

Cuts the values in the selected range and temporarily retains them in a buffer. The 

cut values can be pasted to any position by using the paste button. This tool is 

enabled only if one operation channel is selected. 

 

Copying 

Temporarily copies the values in the selected range to a buffer. The copied values 

can be pasted to any position by using the paste button. This tool is enabled only if 

one operation channel is selected. 

 

Pasting 

Pastes the data temporarily retained in a buffer. The position to which to paste the 

data must be selected as a range. Multiple channels can be selected for pasting. 

Values that were cut or copied when one channel was selected are applied to the 

values of the selected channels. 

 

Undo 
Undoes the previous operation. This can be used to undo only the most recent 

operation. 
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(3) When editing has been completed, click [OK]. 

 

 

 

(4) Click 
 
icon or select Menu → [File] → [Save] to save the project. 

 

4. 3. 3 Analog Input mode 

In this mode, the LEDs are dimmed according to the A/D converted values. 
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(1) Select the [Analog Input] button in Dimmer Program and specify from the [use] drop-down list the A/D 

conversion port to be used for the dimming value. 

 

 

  (For RL78/I1A DCDC LED Control Evaluation Board) 

 

 [each channel] 

The conversion value of each A/D conversion port is applied to the dimming values of the 

corresponding effective channel. 

   <Example> When Channels 1 and 2 are effective 

       ANI0 → Channel 1 

       ANI1 → Channel 2 

 [ANIx only] 

The conversion value of the selected A/D conversion port is applied to the dimming value of all 

effective channels. 

   <Example> When ANI3 is selected and Channels 1 and 2 are effective 

       ANI3 → Channel 1, 2 

 

Caution ANIx varies depending on the evaluation board. 

 

(2) Set the number of samples to be used in moving average processing. 

 

 

 

Caution When the number of samples is set to 1, the moving average processing is not performed. 

 

(3) Click
 
icon or select Menu → [File] → [Save] to save the project. 

 

Remarks1. To use this mode, an analog signal source must be connected to the analog input port (ANI) of 

the microcontroller. For details, refer to the user’s manuals of the microcontroller and evaluation 

board. 

    2. The moving average interval is 5 ms. 
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4. 3. 4 Serial Command mode 

In this mode, the LEDs are dimmed by using commands depending on the type of communication. 

Specify the communication format, communication command type, and channels to use for serial 

communication. 

To use this mode, a host controller for serial communication must be connected to the serial communication 

port of the evaluation board. For details, refer to the user’s manuals of the microcontroller and evaluation 

board. 

For the command of Serial Command mode, refer to APPENDIX B SERIAL COMMAND MODE 

COMMUNICATION COMMANDS. 

 

 

 

(1) Select the [Serial Command] button in Dimmer Program and specify from the [by] and [type] drop-down 

lists the communication mode and communication command system to be used, respectively. 

 [by] 

   Select from UART1Note 1, 

UART1 Serial communication is performed in this mode by using UART (Universal Asynchronous 

Receiver Transmitter) with the TxD1 or RxD1 pin of the device. 

 [type]Note 2 

   Select from ASCII and BINARY. 
 

ASCII Communication by using ASCII codes is performed. 

BINARY Communication by using binary data is performed. 

 

(2) Click
 
icon or select Menu → [File] → [Save] to save the project. 

 

Notes1. The communication system which can be specified now is only UART1. 

    2. [type] can be set only if UART is selected. 
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4. 3. 5 DMX512 mode 

In this mode, the LEDs are dimmed by using the DMX512 protocol. 

For the communication command of DMX512, refer to APPENDIX C DMX512 MODE COMMUNICATION 

DATA. 

 

 

 

(1) Select the [DMX512] button in Dimmer Program. 

(2) Push the [Setting] button and then [DMX512 Property] in the menu, and then specify the channel number. 

For details about this setting, see the [DMX512 Property] dialog box described in CHAPTER 5 WINDOW 

REFERENCE. 

(3) Click 
 
icon or select Menu → [File] → [Save] to save the project. 
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4. 3. 6 DALI mode 

In this mode, the LEDs are dimmed by using the DALI protocol. 

DALI (Digital Addressable Lighting Interface) is an international open standard lighting control communication 

protocol, mainly used for light control of multiple fluorescent lamps or LED lights. 

For the communication command of DALI, refer to APPENDIX D DALI MODE COMMUNICATION DATA. 

 

 

 

(1) Select the [DALI] button in Dimmer Program. 

(2) Open the [DALI Property] dialog box by clicking the [Variable] button, and then specify the parameter. For 

details about this setting, see the [DALI Property] dialog box described in CHAPTER 5 WINDOW 

REFERENCE. 

(3) IEC62386-102+207 ed1.0 and IEC62386-102 ed2.0 is available for the setting of the memory bank. Open 

the [DALI Property Memorybank] dialog box by clicking the [Memorybank] button, and then specify the 

parameter. For details about this setting, see the [DALI Property Memorybank] dialog box described in 

CHAPTER 5 WINDOW REFERENCE. 

(4) Click icon or select Menu → [File] → [Save] to save the project. 

 

Caution  For DALI communication, it's possible to output source files at the time of IEC62386-102 ed1.0 

standard selection. 

The hex files are output at the time of IEC62386-102+207 ed1.0 and the IEC62386-102 ed2.0 

standard selection, and you cannot call the integrated development environment. 

For IEC62386-102+ 207 ed1.0 and IEC62386-102 ed2.0, a library is prepared separately. 

For details, contact your local Renesas Electronics sales. 

<R> 
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4. 3. 7 Switch mode 

In this mode, light is controlled depending on the switches connected to the board. 

Switch mode has 2 modes. 

Mode1: Fade mode 

You can press and hold the switch to gradually raise or lower (fade) the dimming level. 

Press and release the switch to turn the light ON or OFF. 

Direction of the dimming level of the raise/lower by pressing and holding switches every time you press and 

hold. 

Mode 2: Level dimming mode 

Go to 15→20→30→50→100→50→30→20→15 [%] by pressing down the switch to change the dimming 

level in steps. 
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4. 3. 8 IR Remote controller control mode 

In this mode, lights are dimmed by using the on-board function for receiving remote control signals. Remote 

control signals in the NEC format can be received. 

In this mode, the custom code and data code can be specified as a four-digit and a two-digit hexadecimal 

respectively. The dimming level is changed as OFF --> 100% --> 50% --> 10% --> OFF every time the remote 

control code is received. 

When an evaluation is performed using the infrared remote control function of the Lighting Communication 

Master Evaluation Board, which is optionally available, set the following values based on the channel settings 

on the master evaluation board. 
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4. 3. 9 Master Control mode 

This mode is only for RL78/I1A Lighting Communication Master Evaluation Board. 

It is possible not only to control the slave connected to the DALI Master Control GUI and DMX512 Master 

Control GUI, but also to transmit the DALI and IR commands by the implemented 9 switches without Master 

Control GUI. 

 

 

(1) Select the [RL78/I1A Lighting Communication Master Evalution Board] in the [Board Property] dialog box. 

(2) Other than the [Master Control] button in Dimmer Program cannot be selected. 

(3) Open the [Master Control Setting] dialog box by clicking the [Setting] button, and then specify the 

operation of 9 switches. For details about this setting, see the [Master Control Setting] dialog box 

described in CHAPTER 5 WINDOW REFERENCE. 

 

<R> 
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4. 4 Generation, Writing, and Evaluation 
 

Object codes (*.hex) are automatically generated and software is written to a microcontroller. 

After writing has been completed, the operation can be checked by using the evaluation board. 

The writing procedure differs depending on the board used. 

 

(1) Click 
 
icon to open the Build window. Preparation for generating object codes (*.hex) and writing will 

be performed. 
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Remark If an abnormality occurs during object code generation (*.hex) or flash writing, an error code may be 

displayed. 

 Example: "code = xx" 

 Take the following countermeasures according to the code number (xx) displayed. 

 
 

Code No. Countermeasures 

2 Applilet EZ for HCD Controller may not be correctly installed. Reinstall it. 

3 Data cannot be written because the folder that should be set via the [Folders...] setting on the [Setting] 

menu does not exist. 

Re-set an appropriate folder. 

4 The compiler or assembler selected via the [Compiler] setting on the [Setting] menu cannot be found. 

Check whether the compiler or assembler is correctly selected and installed. If it still cannot be found, 

reinstall the compiler or assembler. 

5 The compiler or assembler selected via the [Compiler] setting on the [Setting] menu is not correctly 

installed. 

Reinstall the compiler or assembler. 

9 The folder set via the [Folders...] setting on the [Setting] menu or the BASEPROJECT folder in the 

installation folder of Applilet EZ for HCD Controller is set as a read-only folder. 

Cancel the read-only setting for the whole folder. 

23 This is a system error of the compiler or assembler selected via the [Compiler] setting on the [Setting] 

menu or the main body of Applilet EZ for HCD Controller. 

Handle this error by checking the following points. 

If a read-only folder or file exists under the folder set via the [Folders...] setting on the [Setting] menu, 

cancel all read-only settings. 

If the error still cannot be fixed, reinstall the compiler or assembler and the main body of Applilet EZ for 

HCD Controller. 

26 Illegal value of DALI propaty. Details of the error are displayed by text as below. If two or more errors 

exist, only the first detected error is displayed. 

"Power-On Level" < "Min. Level", "Power-On Level" > "Max. Level", 

"System Failure Level" < "Min. Level", "System Failure Level" > "Max. Level" 

"Min. Level" < "Physical Min. Level", "Min. Level" > "Max. Level", "Min. Level" < 1 

"Min. Level" > 254, "Max. Level" < "Min. Level", "Max. Level" > 254,  

"Max. Level" < 1, "Fade Rate" < 1, "Fade Rate" > 15, "Fade Time" < 1 

"Fade Time" >15, "Random Address" < 0x000000, "Random Address" > 0xFFFFFF 

 

(2) Writing preparation 

<R> If the board has a USB interface 

 Check that the PC and the evaluation board are correctly connected with a USB cable. 

 Depending on the evaluation board, there are those that require switching the features of "write / normal 

operation" by the DipSW. After checking the manual of each evaluation board, when needing setting change, 

turn on the power in the state of writing. 

 

<R> If the board is using E1 

 Connect the PC, E1 and the evaluation board to each other correctly. 

 Depending on the evaluation board, there are those that require switching the features of "write / normal 

operation" by the DipSW. After checking the manual of each evaluation board, when needing setting change, 

turn on the power in the state of writing. 
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(3) Writing 

<R> If the board has a USB interface 

 Click [OK] and flash programming is started. 
 

 

↓ 

 

 

<R> If the board is using E1 

 Click [OK] and flash programming is started. 

 
 

 

↓ 
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(4) Operating preparation 

<R> If the board has a USB interface 

When the program has been written normally, turn the evaluation board off. 

If it is necessary to switch features of "write / normal operation", turn on the power of an evaluation board 

again after switching to "normal operation ". 

 

<R> If the board is using E1 

After the writing of the program is completed successfully, turn off the power to the board, and then remove 

the E1. 

If it is necessary to switch features of "write / normal operation", turn on the power of an evaluation board 

again after switching to "normal operation ". 

 

(5) Operating 

<R> For RL78/I1A AC/DC Full digital 3ch LED control unit and RL78/I1A AC/DC 2 converter LED evaluation 

unit 

 Perform the auto tuning operation (lights all the LEDs of the connected channels) first to check the 

characteristics of the connected LEDs. Start the auto tuning by pushing the switchNote1 after power ON. The 

operation of auto selected program starts after the auto tuning. 

If an illegal condition (such as internal overvoltage) occurs, the LEDs are automatically turned off and the 

operation backs before auto tuning. In that case, push the switchNote1 again to start again from the auto 

tuning.Note 

 

<R> For boards other than the above 

 The operation will start immediately when the power is turned ON. 

 

Note 1 Use the switch 1 (SW1) on RL78/I1A AC/DC Full digital 3ch LED control unit, and use switch 5 (SW5) 

on RL78/I1A AC/DC 2 converter LED evaluation unit. 

  2 When protection against the circuit by the comparator is actuated on RL78/I1A AC/DC Full digital 3ch 

LED control unit, the status lamp will be turned on and off. In such cases, push a reset switch to start 

again. 

 

Caution Since the "write / normal operation" procedure differs depending on the board used, refer to the 

board’s manual for details. 

 

Remark When only generating object codes (*.hex), click 
 
icon. 
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CHAPTER 5 WINDOW REFERENCE 

5. 1 Overview of Windows and Dialog Boxes 

 

The following windows and dialog boxes are provided with Applilet EZ for HCD Controller. 

 

Table 5-1 List of Windows and Dialog Boxes in Applilet EZ for HCD Controller 

Window/Dialog Box Name Description 

Main window This window is opened automatically when Applilet EZ for HCD Controller is 

started. 

This window is used to select and set all functions to be included in the 

automatically generated object codes. 

[UARTx Settings] dialog box This dialog box is used to set UARTx. 

[DALI Property] dialog box This dialog box is used to save variable settings of DALI. 

[DALI Property Memorybank] dialog box This dialog box is used to set memory bank configuration of DALI. 

It's effective only at the time of selection of IEC62386-102+207 ed1.0 and 

IEC62386-102 ed2.0. 

[DMX512 Property] dialog box This dialog box is used to set DMX512. 

[Master control setting] dialog box This dialog box is used to set SW2 to 10 of Lighting Communication Master 

Evaluation Board. 

[SW X Setting] dialog box This dialog box is used to set SW X of Lighting Communication Master 

Evaluation Board. 

[Board Property] dialog box This dialog box is used to set the evaluation board. 

For details, refer to 4.2. 

[Setting to use Compiler] Set the installed folder of the compiler to use. 

For details, refer to 3.1.1. 

[FLASH Programming Settings] 

dialog box 

This dialog box is used to set flash programming. 

For details, refer to 3.1.1. 

[Project Folder] dialog box This dialog box is used to set a folder into which the generated file is to be 

saved. 

For details, refer to 3.1.1. 

 

<R> 
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5. 2 Description of Windows and Dialog Boxes 

 

The following format is mainly used to describe Applilet EZ for HCD Controller’s windows and dialog boxes. 

 

Window/dialog box name 

 

The name of the window or dialog box is indicated in this text frame. 

Next, the window or dialog box’s functions are described briefly and an illustration of the window or dialog box is 

shown. 

 

Menu bar 

 

The options that appear in pull-down menus under each item in the window’s menu bar are enumerated and 

described briefly. 

 

Tool bar 

 

The functions corresponding to the buttons in the window’s tool bar are described. 

 

Description of function-related areas 

 

The areas corresponding to functions set via the dialog box are described below. 

 

Function buttons 

 

The various function buttons in the dialog box are described. 

 

Other 

 

Operation methods, functions, and other noteworthy items or caution points are described. 
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Main window 

 

This window is opened automatically when Applilet EZ for HCD Controller is started. 

Setting items (Setting up the evaluation board, mode setting (refer to 4.2 and 4.3), etc.) are sequentially selected 

in this window to automatically generate object codes (*.hex) that can be directly written to the flash memory of a 

microcontroller. 

 

Figure5-1 Main Window 

 

 

 

 

 

 

 

 

The following parts of this window are described below. 

 Menu bar 

 Tool bar 

 

Note  For the mode setting area, refer to 4.3 Mode Setting. 

Menu bar Tool bar Mode setting areaNote 

Setting content display 

area 
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Menu bar 

 

(1)  [File] menu 

 

[Create New] This option is used to create a new setting. 

Clicking the  button selects the same function. 

[Open...] This option is used to open an existing setting file. 

Use the dialog box that opens for this option to select the existing setting file (*.xml). 

Clicking the  selects the same function. 

[Save] This option is used to save the current settings. 

Clicking the  button selects the same function. 

[Save as...] This option is used to save the current settings with a newly named. 

[Exit] This option is used to close Applilet EZ for HCD Controller. 

[Read Sample Project…] This option is used to read a setting file created as a sample. 

The dialogue box specified the folder that the sample setting file is saved is displayed. 

Please select the sample setting file to use. 

 

(2)  [Project] menu 

 

[Cpu...] This option is used to open the [Board Property] dialog box which sets an evaluation 

board. 

[UARTx...] This option is used to open the [UARTx Settings] dialog box which sets UARTx. 

[DALI...] This option is used to open the [DALI Property Variable] dialog box which sets DALI. 

[DMX512...] This option is used to open the [DMX512 Property] dialog box which sets DMX512. 

 

(3)  [Build] menu 

 

[Generate and Build] Executes automatic generation of object codes (*.hex). 

Clicking the  button selects the same function. 

[FLASH Programming] Writes an already generated object codes (*.hex). 

Clicking the  button selects the same function. 

[All procedure] Executes automatic generation and writing of object codes (*.hex). 

For the procedures from generation to writing, refer to 4.4 Generation, Writing, and 

Evaluation. 

Clicking the  button selects the same function. 
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(4)  [Setting] menu 

 

[Select Compiler] Select the compiler to be used. 

[Compiler Folder...] This option is used to open the [Setting to use compiler] dialog box which sets 

Compiler installed folder to use. 

[FLASH Program...] This option is used to open the [FLASH Programming Settings] dialog box which sets 

flash programming. 

[Project Folder...] This option is used to open the [FLASH Programming Settings] dialog box which sets 

folder to save the generated files. 

 

(5)  [Help] menu 

 

[Version...] This option is used to display version information about Applilet EZ for HCD Controller. 

 

Tool bar 

 

The icons on the Tool bar are provided to enable one-click selection of frequently used menu items. 

 

 This selects the same function as when [Create New] is selected in the [File] menu. 

 This selects the same function as when [Open...] is selected in the [File] menu. 

 This selects the same function as when [Save] is selected in the [File] menu. 

 This selects the same function as when [Generate and Build] is selected in the [Build] 

menu. 

 This selects the same function as when [FLASH Programming] is selected in the 

[Build] menu. 

 This selects the same function as when [All procedure] is selected in the [Build] menu. 
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[UARTx Settings] dialog box 

 

This dialog box can be opened by clicking [UARTx...] in the [Project] menu. 

Set UARTx in this dialog box. 

The setting items are identical in both dialog boxes. The [UARTx Settings] dialog box is used below as an 

example. 

 

Figure5-2 [UARTx Settings] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Speed: 

This can be selected from 9,600, 19,200, and 115,200 bps. 

 

(2) Data bits: 

This is fixed to 8 bits and cannot be changed. 

 

(3) Parity: 

This can be selected from None, Odd, and Even. 

 

(4) Start bit:, Stop bit: 

These are fixed to LSB and 1 bit respectively, and cannot be changed. 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 

(1) 

(2) 

(3) 

(4) 
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[DALI Property] dialog box (IEC62386-102 ed1.0) 

 

This dialog box can be opened by clicking [DALI...] in the [Project] menu or clicking [Variable] after selecting the 

edition to [IEC62386-102 ed1.0]. 

Set parameter of DALI in this dialog box. 

 

Figure5-3 [DALI Property] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Version Number: 

Specify the version number of the evaluation board (as a value from 0 to 255). 

 

(2) Short Address: 

Specify the default address of the evaluation board (as a value from 0 to 63 and 255) 

 

Caution When the short address is assigned to the same address of the mounted LED channels, a right 

result may not be acquired in command replies such as Query. 

 
  

(11) 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

(9) 

(10) 
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(3) Random Address: 

Specify a value when assigning a random address to the evaluation board. 

Set random address value (0 to 255) to Random Address(H),(M),(L). 

 

Caution  When the Random Address(H),(M),(L) are assigned to the same address of the mounted 

LED channels, a short address cannot be set definitely in Random Address Allocation. 

 

(4) Physical Min. Level: 

Specify physical minimum dimming level (as a value from 1 to 254) of the connected lamp on the 

evaluation board or the evaluation board. 

 

(5) Power-On Level: 

Specify the dimming level for when turning on power (as a value from 1 to 255). 

 

(6) System Failure Level: 

Specify the dimming level for when a failure occurs (as a value from 0 to 255). 

 

(7) Max. Level: 

Specify the maximum dimming level (as a value from the minimum level to 254). 

 

(8) Min. Level: 

Specify the minimum dimming level (as a value from the physical minimum level to the maximum level). 

 

(9) Fade Rate: 

Specify the amount by which the dimming level is changed by fading (as a value from 1 to 15). 

 

(10) Fade Time: 

Specify the time required for the dimming level to be changed by fading (as a value from 0 to 15). 

 

(11) Group 

Specify the group the evaluation board belongs to. Multiple groups can be specified. 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 
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[DALI Property Variable] dialog box (IEC62386-102+207 ed1.0) 

 

This dialog box can be opened by clicking [DALI...] in the [Project] menu or clicking [Variable] after selecting the 

edition to [IEC62386-102+207 ed1.0]. 

Set parameter of DALI in this dialog box. 

 

Figure5-4 [DALI Property] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Short Address: 

Specify the default address of the evaluation board (as a value from 0 to 63 and 255) 

 

Caution When the short address is assigned to the same address of the mounted LED channels, a right 

result may not be acquired in command replies such as Query. 
 
  

(14) 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

(9) 

(10) 

(11) 

(12) 

(16) 

(15) 

(13) 

<R> 
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(2) Random Address: 

Specify a value when assigning a random address to the evaluation board. 

Set random address value (0 to 255) to Random Address(H),(M),(L). 

 

Caution When the Random Address(H),(M),(L) are assigned to the same address of the mounted LED 

channels, a short address cannot be set definitely in Random Address Allocation. 

 

(3) Physical Min. Level: 

Specify physical minimum dimming level (as a value from 1 to 254) of the connected lamp on the 

evaluation board or the evaluation board. 

For non-linear (curve 0) and linear (curve 1), because it is different for the physical minimum dimming 

level, it is necessary to set in each. 

 

(4) Power-On Level: 

Specify the dimming level for when turning on power (as a value from 1 to 255). 

 

(5) System Failure Level: 

Specify the dimming level for when a failure occurs (as a value from 0 to 255). 

 

(6) Max. Level: 

Specify the maximum dimming level (as a value from the minimum level to 254). 

 

(7) Min. Level: 

Specify the minimum dimming level (as a value from the physical minimum level to the maximum level). 

 

(8) Fade Rate: 

Specify the amount by which the dimming level is changed by fading (as a value from 1 to 15). 

 

(9) Fade Time: 

Specify the time required for the dimming level to be changed by fading (as a value from 0 to 15). 

 

(10) Min Fast Fade Time: 

Specify the minimum set value of the high-speed fade time (as a value from 1 to 27). 

 

(11) Fast Fade Time: 

Specify the time required for the dimming level to be changed by fast fading (as a value from 0 and from 

Min Fast Fade Time to 27). 

 

(12) Dimming Curve 

Specify a dimming curve (0: logarithm curve 1: a fault logarithm curve) to use. 

 

(13) Group 

Specify the group the evaluation board belongs to. Multiple groups can be specified. 
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(14) Features 

Specify the hardware features of the evaluation board. It is possible to select multiple. 

 

(15) Possible Operating Modes 

Specify the operational mode on the evaluation board. It is possible to select multiple. 

 

(16) Gear Type 

Specify the type of the evaluation board. It is possible to select multiple. 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 
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[DALI Property Variable] dialog box (IEC62386-102 ed2.0) 

 

This dialog box can be opened by clicking [DALI...] in the [Project] menu or clicking [Variable] after selecting the 

edition to [IEC62386-102 ed2.0]. 

Set parameter of DALI in this dialog box. 

 

Figure5-5 [DALI Property] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Short Address: 

Specify the default address of the evaluation board (as a value from 0 to 63 and 255). 

 

Caution When the short address is assigned to the same address of the mounted LED channels, a right 

result may not be acquired in command replies such as Query. 

 
  

(13) 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

(9) 

(10) 

(11) 

(12) 

<R> 
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(2) Random Address: 

Specify a value when assigning a random address to the evaluation board. 

Set random address value (0 to 255) to Random Address(H),(M),(L). 

 

Caution When the Random Address(H),(M),(L) are assigned to the same address of the mounted LED 

channels, a short address cannot be set definitely in Random Address Allocation. 

 

(3) Physical Min. Level: 

Specify physical minimum dimming level (as a value from 1 to 254) of the connected lamp on the 

evaluation board or the evaluation board. 

 

(4) Power-On Level: 

Specify the dimming level for when turning on power (as a value from 1 to 255). 

 

(5) System Failure Level: 

Specify the dimming level for when a failure occurs (as a value from 0 to 255). 

 

(6) Max. Level: 

Specify the maximum dimming level (as a value from the minimum level to 254). 

 

(7) Min. Level: 

Specify the minimum dimming level (as a value from the physical minimum level to the maximum level). 

 

(8) Fade Rate: 

Specify the amount by which the dimming level is changed by fading (as a value from 1 to 15). 

 

(9) Fade Time: 

Specify the time required for the dimming level to be changed by fading (as a value from 0 to 15). 

 

(10) Extended Fade Time Base: 

Specify base value of the extended fade time of dimming (as a value from 0 to 15). 

 

(11) Extended Fade Time Multiplier: 

Specify multiplier value of the extended fade time of dimming (as a value from 0 to 4). 

 

(12) Specific Mode: 

Specify the time (0 and as a value from 128 to 255) required for the dimming level to be changed. 

 

(13) Group 

Specify the group the evaluation board belongs to. Multiple groups can be specified. 
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Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 
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[DALI Property Memorybank] dialog box (IEC62386-102+207 ed1.0) 

 

This dialog box can be opened by clicking [Memorybank] after selecting the edition to [IEC62386-102+207 

ed1.0]. 

Set Memorybank parameter of DALI in this dialog box. 

 

Figure5-6 [DALI Property Memorybank] dialog box 

 

 

 

 

 

 

(2) (3) 

(1) 

(4) 

(6) 

(7) 

(8) 

(9) 

(5) 

<R> 
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The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Selection Memorybank TAB 

Select the Memorybank to be set. 

 

(2) GTIN byte: 

Set GTIN: Global Trade Item Number (international standard for product identification code) of evaluation 

board. 

 

(3) Serial number byte: 

Set the serial number of the evaluation board. 

 

(4) OEM GTIN byte: 

Set the GTIN (the international standard for product identification code) that OEM of the evaluation board 

sets. 

 

(5) OEM Serial number byte: 

Set the serial number that OEM of the evaluation board sets. 

 

(6) channel TAB: 

Select the logical device of the evaluation board. 

 

(7) Subsystem and Device: 

Set the subsystem number (bit7-4) and device number (bit3-0) including Control gear. 

 

(8)Lamp type number(lockable): 

Set the lamp type. It is protected by the Lock byte. 

 

(9) Lamp type number: 

Set the lamp type. 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 
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[DALI Property Memorybank] dialog box (IEC62386-102 ed2.0) 

 

This dialog box can be opened by clicking [Memorybank] after selecting the edition to [IEC62386-102 ed2.0]. 

Set Memorybank parameter of DALI in this dialog box. 

 

Figure5-7 [DALI Property Memorybank] dialog box 

 

 

 

 

 

(2) (4) 

(1) 

(9) 

(11) 

(10) 

(3) 

(5) 

(6) 

(7) 

(8) 

<R> 
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The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Selection Memorybank TAB 

Select the Memorybank to be set. 

 

(2) GTIN byte: 

Set GTIN: Global Trade Item Number (international standard for product identification code) of evaluation 

board. 

 

(3) Hardware Version: 

Set Hardware Version [major] [minor] of evaluation board. 

 

(4) Identification number byte: 

Set the Identification number of evaluation board. 

 

(5) channel TAB : 

Select the logical device of the evaluation board. 

 

(6) 101 version number: 

Select the IEC62386-101 version number to be used on the evaluation board. 

 

Caution This item is common to all channels. This can be set only on youngest TAB of channel number. 

 

(7) Number of logical control gear unit in the bus unit: 

Set the number of connected Control gear on the same BUS unit. 

 

Caution This item is common to all channels. This can be set only on youngest TAB of channel number. 

 

(8) Index number of this logical control gear unit: 

Set the index number of Control gear connected on the same BUS unit (as a value from 1 to Number of 

logical control gear unit in the bus unit - 1). 

This number is used as Short Address Number in Random Address Allocation. 

 

Caution As for this number, the overlap on the same BUN unit is not forgiven. When overlapping, it 

becomes the overlap error in Random Address Allocation and cannot set Short Address 

Number. 
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(9) OEM GTIN byte: 

Set the GTIN (the international standard for product identification code) that OEM of the evaluation board 

sets. 

 

(10) OEM Identification number byte: 

Set the Identification number that OEM of evaluation board sets. 

 

(11) Indicator byte: 

Purpose and the set value of this byte are left to the manufacturer. Set the value the manufacturer has 

decided (as a value from 0 to 255). 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 
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[DMX512 Property] dialog box 

 

This dialog box can be opened by clicking [DMX512...] in the [Project] menu. 

Set channel numbers of DMX512 in this dialog box. 

 

Figure5-8 [DMX512 Property] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Channel X 

Enter a number from 1 to 512 in order to assign each channel to a slot (channel) of the DMX512 protocol. 

If an existing setting file is open, the value in that file is displayed. 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 

 
  

(1) 
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[Master Control Setting] dialog box 

 

This dialog box can be opened by clicking [Setting..] button on the [Master control]. 

Set transmission contents setting of SW 2 to 10 on Lighting Communication Master Evaluation Board in this 

dialog box. 

 

FIgure5-9 [Master Control Setting] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) SW X settings dialog box display button 

Display the settings dialog box for each SW. 

In the dialog box, the value that set currently is displayed. 

 

(2) SW X setting display 

Display the contents set currently for each SW. 

(2) (1) 

<R> 
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(a) Setting Protocol Display 

Protocol set for each SW is displayed. 

Displayed protocol 

 DALI:  DALI protocol 

 IR : IR protocol 

 

(b) Setting Command Display 

Command set for each SW is displayed. 

 DALI: Setting address + Command 

 IR: Custom Code + Data Code + Setting Ch1 + Setting Ch2 

 

(c) Setting Operation mode Display 

Operation mode setting when you hold down the SW X is displayed. 

 Once: Single transmission (command only transmit once) 

 Resend: Continuous transmission (command transmitted every 150msec) 

 Repeat: Continuous transmission (Repeat command transmitted every 108msec, when the 

IR only) 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 

  

(a) 

(b) 

(c) 
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[SW X Setting] dialog box 

 

This dialog box can be opened by clicking [SW X] button on the [Master control Setting] dialog box. 

Set transmission of SW X in this dialog box. 

 

FIgure5-10 [Master Control Setting] dialog box 

 

 

 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 

 

(1) Mode selection radio button 

Set a mode (DALI or IR protocol) to set in SW. 

 

(2) Setting of DALI command 

Set a transmission command in DALI. 

 

 

 
  

(2) 

(1) 

(3) 

(a) (b) (c) (d) 

(e) 

<R> 
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(a) Setting of address type 

Set an address type of DALI protocol. 

Setable address type 

 Broadcast: Broadcast (all devices) transmission 

 Group Address: Group address (group setting device) transmission 

 Short Address: Short address (individual devices) transmission 

 

(b) Setting of address 

Set an address number at the time of the group address of the DALI protocol or the short address 

setting. 

Setable range 

 Group Address: 0 to 15 

 Short Address: 0 to 63 

 

(c) Setting of command 

Set a command of DALI protocol 

Setable command 

 DAPC:   Dimming the specified dimming level according to the Fade 

   time 

 OFF:   Turn off 

 UP:   UP the 200msec dimming level according to the Fade rate. 

 DOWN:   DOWN the 200msec dimming level according to the Fade rate. 

 STEP UP:  Dimming level +1 (impossible to OFF) 

 STEP DOWN:  Dimming level -1 (impossible from OFF) 

 RECALL MAX LEVEL: Maximize dimming level 

 RECALL MIN LEVEL: Minimize dimming level 

 STEP DOWN AND OFF: Dimming level -1 (possible to OFF) 

 ON AND STEP UP: Dimming level +1 (possible from OFF) 

 GO TO SCENE:  Dimming to Scene value that is set according to Fade time. 

 

(d) Setting of operation mode 

Set the operating mode when SW that is set to DALI protocol is continued to be pushed. 

Setable operation mode 

 Once: Single transmission (command only transmit once) 

 Resend: Continuous transmission (command transmitted every 150msec) 

 

(d) Setting of command parameter 

Set the parameters (data) to be set in the DALI protocol command. 

Setable parameter 

 DAPC:  0 to 255 

 GO TO SCENE: 0 to 15 

 Other:  Setting disable 
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(3)Setting of IR command 

Set the transmission command in the IR mode. 

 

 

 

(a) Customer code 

Set the manufacturer identification code. 

 Setting range: 0000h－FFFFh 

 

(b) Channel 1 code 

Set control data at the time of the Channel 1 setting. 

 Setting range: 00h－FFh 

 

(c) Channel 2 code 

Set control data at the time of the Channel 2 setting. 

 Setting range: 00h－FFh 

 

(d) Setting of operation mode 

Set the operating mode when SW that is set to DALI protocol is continued to be pushed. 

Setable operation mode 

 Once: Single transmission (command only transmit once) 

 Resend: Continuous transmission (command transmitted every 150msec) 

 Repeat: Continuous transmission (Repeat command transmitted every 108msec, when the 

IR only) 

 

Function buttons 

 

Button Description 

 
Click this button to save the current settings and close the open dialog box. 

 
Click this button to close the open dialog box without saving the current settings. 

 

(a) (b) (c) (d) 
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APPENDIX A SAMPLE FILE 

 This chapter introduces sample files for specific colors. 

 These sample files are stored in the following folder. 

  -C:¥Program Files(x86)¥Renesas Electronics¥ Applilet EZ for HCD Ver9.0¥Sample¥Board name¥ 

 

Sample File Name Description Operation Mode 

Flash_xxxxx.xml Flash Variable mode 

Rainbow_xxxxx.xml Rainbow 

Random_xxxxx.xml Random color 

 

Remarks 1. In the sample file names, "xxxxx" represents the name of an evaluation board. 

     2.  Depending on the board, these files may not exist. 

     3.  If the LED being beforehand mounted on a board is changed, the color may be changed. 
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APPENDIX B SERIAL COMMAND MODE COMMUNICATION COMMANDS 

This chapter describes the communication commands used between a host device (such as a PC or a 

microcontroller) and a target device (evaluation board). An application software that uses the communication 

commands can be generated by selecting [Serial Command] on the Applilet EZ for HCD Controller and determining 

the communication method. Refer to 4.3.4 for operation details. 

 

 

 

The communication methods that can be selected with the Serial Command mode are UART1. 

About type of data, binary types and ASCII types of these communication methods can be selected. 

Refer to B.1 Overview of Binary Type, B.2 Overview of ASCII Type for details of each type. 

Refer to B.3 for the timings of each communication method. 

 

 

B.1 Overview of Binary Type 

 

Basic format 1 (host →target) 

 

 

Basic format 2 (target → host) 

 

 

Basic formats 1 and 2 are binary type communication formats. Basic format 1 is used to transmit data from a host 

device to a target device and consists of a startcode block, a command block, and a parameter block. Basic format 2 

is used to transmit data from a target device to a host device and consists of only a parameter block. 

Details of each block are described below. 

  

8 bit 

parameter 

parameter block 

parameter 

8 bit 

startcode command ch R/W startcode parameter parameter 

startcode block command block parameter block 

8 bit 8 bit 5 bit 1 bit 2 bit 8 bit 8 bit 

Host Machine 
(PC, microcontroller, etc) 

Target 
(RL78/I1A DCDC LED Control 

Evaluation Board,  
RL78/I1A AC/DC Full digital 3ch 

LED control unit, etc) 

Various communications interfaces 

<R> 
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B. 1. 1 Details of basic format 1 (host → target) 

-startcode block 

2 [byte] data, each byte consisting of 8 bits fixed to 0. It is required when transmitting data from a host 

device to a target device. 

 

-command block 

1 [byte] data consisting of 8 bits. The meaning of each bit is as follows. 

R/W (1 bit): This bit specifies the flow of information. Whether status acquisition is requested to 

the target device or an operation status is set to the target device changes, depending 

on this bit. 

1 (READ): This specifies status acquisition (during reception). 

0 (WRITE): This specifies setting (during transmission). 

Command (5 bit): These bits specify the items whose status is to be acquired (during reception) or that 

is to be set (during transmission). The following one item type exist and their 

meanings vary, depending on whether they are set to status acquisition (during 

reception) or setting (during transmission). 

01000 (Dimming value): This item represents the dimming value 

Status acquisition (during reception) =When this command is selected, the target device returns 

as 2 [byte] data the dimming value setting value of the 

channel instructed with "Ch". Refer to B.1.2 for details. 

Setting (during transmission) = When this command is selected, the dimming value of 

the channel instructed with "Ch" is set by using the value 

specified by "parameter". 

Ch (2 bit): These bits specify the target channel. 

 00 Channel1 

 01 Channel2 

 10 Channel3 

 11 Channel4 

-parameter block 

2 [byte] data consisting of 8 bits. 

This block has no meaning when set to status acquisition (during reception: R/W = 1)Note 1. Specify 0x00 

for status acquisition (during reception). 

When it is set to setting (during transmission: R/W = 0), it has the following meaning according to 

"Command (5 bits)"of the Command block. 

01000 (Dimming value): During dimming value setting 

This specifies the dimming value of the channel instructed with "Ch". A value within the range 

of 0 to 0x2710 (10000:100.00%) Note 2 can be specified. 

 

Notes 1. This has no meaning but it cannot be omitted. 

Notes 2. Setting range for future expansion is a 0-10000 (0.00 to 100.00). Since the setting value that 

specifies the same dimming level has a width by the board specifications, even if you set a 

different value, it may be the same dimming level. 
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B. 1. 2 Details of basic format 2 (target → host) 

-parameter block 

2 [byte] data consisting of 8 bits. 

It is not transmitted when the host device has selected setting (during transmission: R/W = 0). 

When status acquisition (during reception: R/W = 1) has been selected, it has the following meaning 

according to "Command (5 bits)". 

01000 (Dimming value): During dimming value setting 

This returns as 2 [byte] data the dimming value setting value of the channel instructed with 

"Ch". 

The dimming value holds a value within the range of 0 to 0x2710 (10000: 100.00%). 

 

 

B. 1. 3 Binary type execution example 

1. Setting the dimming value of channel 1 of the target device to 10.00% 

 Transmission from the host device 

Hexadecimal: 00 00 20 03 E8 

Binary:  0000 0000 0000 0000 0010 0000 0000 0011 1110 1000 

 Reception from the target device 

None 

 

2. Acquiring the dimming value of channel 3 of the target device 

 Transmission from the host device 

Hexadecimal: 00 00 A2 00 00 

Binary:  0000 0000 0000 0000 1010 0010 0000 0000 0000 0000 

 Reception from the target device (dimming value = 50.00%) 

Hexadecimal: 13 88 

Binary:  0001 0011 1000 1000 
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B. 2 Overview of ASCII Type 

 

Basic format 3 (host → target) 

 

 

Basic format 4 (target → host) 

 

The ASCII-type communication format uses ASCII characters for transmission and reception. Similarly with the 

binary type, there are two communication formats of the ASCII type. Basic format 3 is used to transmit data from a 

host device to a target device, consists of a ch block, a cmd block, and a data block, and is delimited by commas. 

Basic format 4 is used to transmit data from a target device to a host device and consists of only a data block. 

Furthermore, LineFeed (0x0D) and CarriageReturn (0x0A) are added to each format. 

 

B. 2. 1 Details of basic format 3 (host → target) 

 ch block 

1 [byte] data. It specifies the channel to be controlled. 

Specifiable values: "1", "2", "3", "4" 

 

 cmd block 

2 [byte] data. It can be used to specify for the dimming value of each channel of the target device, status 

acquisition (during reception) or setting (during transmission). The following four items can be specified. 

Specifiable items: "wd" Set Duty ················ This sets the dimming value of the channel specified with 

the "ch" block. 

 "rd" Read Duty ············· This requests the setting of dimming value of the channel 

specified with the "ch" block. 

When requesting to the target device has been specified, the target device returns the current status. 

Refer to B.2.2 for details. 

 

 data block 

5 [byte] data. It has the following meanings according to the items specified with the cmd block. 

cmd ="wd": This specifies as 5 digits in decimal format the value of the dimming value to be 

set. ("00000" to "10000") Note 1 

cmd ="rd": This specifies "00000" with a dimming value request to the target deviceNote 2. 

 

Notes 1. Setting range for future expansion is a 0-10000 (0.00 to 100.00). Since the setting value that 

specifies the same dimming level has a width by the board specifications, even if you set a different 

value, it may be the same dimming level. 

Notes 2.  When cmd is "rd" and "rs", the data block has no meaning, but it cannot be omitted. 

data LineFeed(0x0D) CarriageReturn(0x0A) 

5byte 1byte 1byte 

1byte 

Comma(0x2C) ch cmd Comma(0x2C) data LineFeed(0x0D) CarriageReturn(0x0A) 

1byte 2byte 1byte 5byte 1byte 1byte 
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B. 2. 2 Details of basic format 4 (target → host) 

 data block 

5 [byte] data. The data is transmitted from the target device only when cmd is "rd", among the items 

specified for basic format 3. 

cmd ="rd": This return as 5 digits in decimal format the dimming value of the specified channel. 

("00000" to "10000") 

 

B. 2. 3 ASCII type execution example 

Remark LineFeed (0x0D) and CarriageReturn (0x0A) are expressed as ¥r and ¥n, respectively, in this 

section. 

 

1. Setting the dimming value of channel 1 of the target device to 10.00% 

 Transmission from the host device 

"1,wd,01000¥r¥n" 

 Reception from the target device 

None 

2. Acquiring the dimming value of channel 3 of the target device 

 Transmission from the host device 

"3,rd,00000¥r¥n" 

 Reception from the target device (dimming value = 50.00%) 

"05000¥r¥n" 
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B. 3 Transmission/Reception Timing According to Communication Method 

 

The method and timing of transmission and reception differ according to the communication method. The 

differences of each communication method are as follows. 

 

<UARTx (ASCII/BINARY)> 

In communication using a UART, transmission and reception are performed completely asynchronously. A 

transmission operation of the target device uses basic format 1 or 3, and occurs only when the host device has 

requested information acquisition (during reception) to the target device. 

 

UART communication example 

 

 

Notes 1. Name of the signal line on the host side 

 2. This is a waveform of when parity has been set to "None". 

 

D0 D1 D6 D7 
ST 
bit 

SP 
bit 

D0 D1 D6 D7 
ST 
bit 

SP 
bit 

Basic format 1 or 3Note2 

Basic format 2 or 4Note2 

Host device transmission Target device transmission 

Host transmission pin (TxDNote 1) 
Target reception 

Host reception pin (RxDNote 1) 
Target transmission 
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APPENDIX C DMX512 MODE COMMUNICATION DATA 

 The communication data by DMX512 mode is described below. 

 

 

Remark RL78/I1A AC/DC 1 converter LED evaluation unit and RL78/I1A AC/DC 2 converter LED evaluation unit 

are not supported DMX. 

 

DMX512 performs communication using the following protocol. 

 

C. 1 Protocol Specifications 

 

<1> Packet 

One packet is configured of one MTBP, one BREAK, one MAB, 513 frames, and 512 MTBFs. 

The first frame is a start code and data is fixed to 0. 

 

 

Name Data width Level 

MIN. TYP. MAX. 

BREAK 88 s 88 s 176 s Low-level 

MAB 8 s 8 s 1 s High-level 

FRAME 44 s 44 s 44 s Low-level/High-level 

MTBF 0 s – 1 s High-level 

MTBP 0 s – 1 s High-level 

MTBP 

Break 

MAB 
Frame 

(Start code) 
Frame 

(Channel 1) 
Frame 

(Channel 512) 

MTBF MTBF 

Host Machine 
(PC, microcontroller, etc.) 

Master board Target 

Target 

Target 

DMX communication 

<R> 
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<2> Frame 

One frame is configured of one start bit, eight data bits, and two stop bits. 

One frame is equivalent to one UART communication data byte with a baud rate of 250 kbps, no parity, and 

two stop bits. 

 

 

Name Data width Level 

Start bit 4 s Low-level 

Data bits 4 s  8 bits Low-level/High-level 

Stop bits 4 s  2 bits High-level 

 

C. 2 Communication Data Specification 

 

 The frame data bits are LSB first. 

 The start code is fixed to 0x00. Packets with a start code other than 0x00 are invalid. 

 Brightness data corresponding to channels 1 to 4 on the board are set to each frame (0 ≤ brightness data 

≤ 255). 

 

Example of communication data 

 

 

 

Break MAB 
Start code 

(0x00) 
 

Channel 1 
(brightness 
level of ch1: 

0x00 to 0xFF) 

 

Channel 2 
(brightness 
level of ch2: 

0x00 to 0xFF) 

   Channel 512 

MTBP MTBP MTBP MTBP 

1 data frame 

start bit stop bit D D D D D D D D 

MTBF 
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APPENDIX D DALI MODE COMMUNICATION DATA 

 The communication data by DALI (Digital Addressable Lighting Interface) mode is described below. 

 

 

 

Remark RL78/I1A AC/DC 1 converter LED evaluation unit is not supported DALI communication. 

 

 DALI performs communication using the following protocol. 

 

D. 1 Protocol Specifications 

 

DALI is a network consisting of up to 64 short addresses and 16 group addresses, and performs half-duplex 

command communication between one master and one slave or multiple slaves. 

DALI commands are used for purposes such as setting the dimming level with 8-bit accuracy and saving or 

switching among up to 16 arbitrary dimming levels. 

The communication speed is 1,200 Hz ±10%. 

 

<1> Bit definition 

A falling edge is bit-defined as "0" and a rising edge as "1", because DALI communication uses 

Manchester code. 

If no communication is performed, DALI communication is fixed to the high level. 

 

FigureD-1 Bit Definition 

 

 

1 1 0 0 1 

Host Machine 
(PC, microcontroller, etc.) 

Master board Target 

Target 

Target 

DALI communication 
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<2> Frame 

 Forward frame 

This is a frame used when transmitting from the master to a slave. A frame consists of 19 bits. 

 

Figure D-2 Forward-Frame Structure 

 

 

a:  Start bit 

This indicates the start of the frame. It is always the same waveform as "1". 

b-d:  Address byte 

This specifies the transmission destination of the frame. 

e:  Data byte 

This specifies a command. 

f:  Stop bits 

These indicate the end of the frame. These are fixed to the high level. 

 

 Backward frame 

This is a frame used when transmitting from the slave to a master. A frame consists of 11 bits. 

 

FigureD-3 Backward-Frame Structure 

 

 

a:  Start bit 

This indicates the start of the frame. It is always the same waveform as "1". 

b:  Data byte 

This replies to the master. 

c:  Stop bits 

These indicate the end of the frame. These are fixed to the high level. 

 

a b c 

1 bit 8 bits 2 bits 

1bit 1 bit 6 bits 1 bit 8 bits 2 bits 

8 bits 

a b c d e f 
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D. 2 Transmission/Reception Timing Rules 

 

<1> Timing in the frame (101ed1.0) 

1 bit width in DALI is 833.3 µs ±10% for both Forward and Backward frames. 

 

FigureD-4 Timing in the Frame 

 

 

Note Because there are two stop bits, their timing is 1666.67 µs. 

 

<2> Timing in the frame (101ed2.0) 

1 bit width in DALI is 833.3 µs for both Forward and Backward frames. 

The allowable range of the bit width is 1 bit = 666.7 µs ≤ 1000 µs. 

 

FigureD-5 Timing in the Frame (The last bit= 0) 

 

 

FigureD-6 Timing in the Frame (The last bit= 1) 

 

Note  The start of the Stop condition starts from the end of the rising edge. 

Starting timing of Stop condition changes whether the last bit is 0 or 1. 

 

 

 

 

Start bit 
833.3μs 

Data bit 
833.3μs 

Data bit 
833.3μs 

Data bit 
416.7μs 

Stop condition 
2400μs 

Start bit 
833.3μs 

Data bit 
833.3μs 

Data bit 
833.3μs 

Data bit 
833.3μs 

Stop condition 
2400μs 

Start bit 
833.3μs 

Data bit 
833.3μs 

Data bit 
833.3μs 

Data bit 
833.3μs 

Stop bit 
1666.67μs 

<R> 
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<3> Timing among frames (101ed1.0) 

With DALI, the following timing must be controlled in frame units. 

 Forward frame width: 15.83 ms±10 % 

 Backward frame width: 9.17 ms±10 % 

 Communication interval between one Forward frame and the Backward frame: 2.92 to 9.17 ms 

 Communication interval between one Forward frame and the next Forward frame: 9.17 ms min. 

 Communication interval between one Backward frame and the next Forward frame: 9.17 ms min. 

 

FigureD-7 Timing among frames 

 
<4> Timing among frames (101ed2.0) 

With DALI, the following timing must be controlled in frame units. 

 Forward frame width: 15.83 ms (12.66 to 19.00ms) 

 Backward frame width: 9.17 ms (7.33ms to 11.00ms) 

 Communication interval between one Forward frame and the Backward frame: 2.4～12.4 ms  

(Settling time) 

 Communication interval between one Forward frame and the next Forward frame: 2.4 ms min. 

(Settling time) 

 Communication interval between one Backward frame and the next Forward frame: 2.4 ms min.  

(Settling time) 

 

FigureD-8 Timing among frames 

 

 

Forward 
frame 

Forward 
frame 

Forward 
frame 

Backward 
frame 

Forward start 
 

Backward start 
 

15.83 ms 

2.4 ms 
min. 

9.17 ms 

 
2.4 to 12.4 ms 

 

2.4 ms 
min. 

Forward 
frame 

Forward 
frame 

Forward 
frame 

Backward 
frame 

Forward start 
 

Backward start 
 

15.83 ms 

9.17 ms 
min. 

9.17 ms 

 
2.92 to 9.17 ms 

 

9.17 ms 
min. 

<R> 
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APPENDIX E RESERVED AREAS USED IN ON-CHIP DEBUGGING 

 The reserved areas shaded in gray in Figures F-1 are used during on-chip debugging. 

 

FigureF-1 Reserved Areas Used in On-chip Debugging (RL78/I1A) 

 

 

Notes 1.  Address differs depending on products as follows. 

Products Address of Note 1 

R5F1076C, R5F107AC, R5F107BC 07FFFH 

R5F107AE, R5F107DE 0FFFFH 

    2. When real-time RAM monitor (RRM) function and Dynamic Memory Modification (DMM) 

function are not used, it is 256 bytes. 

    3. In debugging, reset vector is rewritten to address allocated to a monitor program. 

    4. Since this area is allocated immediately before the stack area, the address of this area varies 

depending on the stack increase and decrease. That is, 4 extra bytes are consumed for the 

stack area used. 

When using self-programming, 12 extra bytes are consumed for the stack area used. 

 

(512 bytes or 
256 bytes Note 2) 

Debug monitor area 
(10 bytes) 

Security ID area 
(10 bytes) 

 

 

 
Debug monitor area 

(2 bytes) 
Note 3 0 0 0 0 0 H 

0 0 0 0 2 H 

0 0 0 C 3 H 
0 0 0 C 4 H 

0 0 0 C E H 

0 0 0 D 8 H 

Note1 

0 1 0 0 0 H 

Use prohibited 

On-chip debug option byte area 
(1 byte) 

Code flash 
area 

Stack area for debugging 

(4 bytes) Note 4 Internal 
ROM space 

SFR area 

Mirror area 

: Area used for debugging 

Code flash memory Internal RAM space 

<R> 
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